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INTRODUCTION

CanEJEX is a user-friendly calculation tool specifically designed to support professionals 
with technical backgrounds in evaluating the potential of gas/gas ejectors in industrial 
process applications where fluid compression or entrainment is desired. The software 
also provides analysis capabilities for two-phase CO² ejectors operating in refrigeration 
and heat pumping conditions. Information on the basic operating principles of ejectors 
and a list of references are provided in the annex.

1.1 SOFTWARE CAPABILITIES

CanEJEX offers two calculation modules, each designed to meet specific engineering 
requirements:

1. Preliminary Design: Evaluates the feasibility of designing an ejector to meet speci-
fic operational requirements. It provides initial estimates of key geometric dimensions
(nozzle throat diameter, nozzle exit diameter, and mixing chamber  diameter). These
estimates facilitate the optimization and final design stages, which require advanced
methods such as Computational Fluid Dynamics (CFD) simulations and experimental
validation.

2. Performance Prediction: Predicts the performance of a specific ejector under various
operating conditions. By inputting three key geometric parameters (nozzle throat diame-
ter, nozzle exit diameter, and mixing chamber diameter), it calculates values for the two
key performance criteria: entrainment ratio and compression ratio.

1.2 WORKING FLUID

CanEJEX supports the analysis of ejectors with multiple working fluids: CH4 , CO² , air, 
water, natural gas mixture, and others.
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Function Description

New Create a new project with default parameters

Open Load an existing project file

Close Close the current project

Save Save the current project

Save As Save the project with a new name

Home Return to the main interface

Quit Exit the application

USER INTERFACE

CanEJEX employs a two-tier tab structure. The primary level consists of four main 
menus, each providing access to corresponding submenus and functionalities.

2.1 INTERFACE OVERVIEW

The main interface is organized into four sections:

1. ‘’File’’ Menu: File management and application control
2. Calculation Menu: Data entry relative to the ejector application and results
3. Options Menu: Language and measurement unit configuration
4. Help Menu: Documentation and support information

2.2 FILE MENU

The File menu provides essential file management and functions:

Table 1: File Menu Functions
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2.3.1 Ejector Tab

The Ejector tab is where all parameters relevant to the ejector application are entered. It 
contains two main sections:

Global Parameters: This section requires entering project  the analysis settings as  
defined in table 3.

Table 3: Global Parameters 

Inputs: This section requires to enter operating conditions specific to the ejector appli-
cation, as well as key ejector geometric parameters when the "Performance prediction" 
model is selected. Inputs vary according to the ejector type (single-phase or two-phase 
CO²). Further details are provided in section 3 of this manual.

2.3.2 Calculate Tab

The Calculate tab triggers the calculation process.

Parameter Type Description

Project Name Text Identifier for the analysis project

Flow Condition Selection Single-phase (gas-gas) or two-phase CO²

Working Fluid Dropdown CH4, CO² , water, air, and others

Model Type Selection Preliminary design or performance prediction

2.3 CALCULATION MENU

The Calculation menu is the heart of CanEJEX and contains all analytical functionality:

Table 2: Calculation Menu Structure

Submenu Functionality

Ejector
Parameter input relevant to ejector application and selection of calculation function 
or module

Calculate Execute the calculation process

Results Display calculation results

Export Export data in various formats

Logs Session calculation history
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2.3.3 Results Tab

The Results tab displays calculation results with performance metrics and operating 
conditions. Results vary based on the selected model type and flow condition. Further 
details are provided in section 3 of this manual.

2.3.4 Export Tab

The Export tab provides data export functionality:

• Excel Export: Complete input and results in Excel format
• CSV Export: Data export in comma-separated values format

2.3.5 Logs Tab

The Logs tab exports all calculations performed during a working session in a single 
Excel file, providing:

• Calculation History: Complete record of all the analyses
• Parameter Tracking: Input parameter changes over time
• Results Comparison: Performance comparison across calculations

2.4 OPTIONS MENU 

The Options menu provides configuration settings for language and units:

Table 4: Options Menu Configuration

Setting Options Description

Language English/French Interface language selection

Units SI/Imperial
Default unit system (individual units can be se- lected per 
parameter)
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EJECTOR ANALYSIS

3.1 SINGLE-PHASE EJECTOR ANALYSIS

3.1.1 Input Operating Parameters

For single-phase (gas-gas) ejector analysis, the required user inputs for operating condi-
tions include: pressure and temperature for both the motive fluid (primary flow) and the 
suction fluid (secondary flow) to be entrained or compressed, as well as the primary 
mass flow rate and the desired ejector outlet pressure.

Table 5: Single-Phase Ejector Input Parameters

03

Parameter Unit Default Description

Primary Pressure kPa - Motive fluid pressure

Primary Temperature °C - Motive fluid temperature

Secondary Pressure kPa - Suction fluid pressure

Secondary Temperature °C - Suction fluid temperature

Primary Mass Flow Rate kg/s - Motive fluid flow rate

Ejector Outlet Pressure kPa - Desired outlet pressure

Isentropic Efficiency - 0,98
Primary nozzle isentropic efficiency (default 
provided)

Loss Coefficient - 0,98
Mixing chamber loss coefficient (default provi-
ded)

2.5 HELP MENU

The Help menu provides support and documentation:

• Software Information: Version details and licensing information
• Contact Us: Contact information and support channels
• License Agreement and License Request: Licensing details and terms of use
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Parameter Range Limitations

Parameter ranges are determined by fluid properties and engineering constraints. The 
software automatically validates inputs against:

• Fluid thermodynamic property limits (temperature and pressure boundaries)
• Physical constraints (positive values for geometric parameters)
• Engineering feasibility (realistic operating conditions)

Default Value Modification

Default values are provided for the isentropic efficiency of the ejector’s primary nozzle 
and the loss coefficient of the mixing chamber. These defaults can be replaced with 
user-defined values by selecting the "Allow value modification" option.

3.1.2 Input Geometric Parameters (Performance Prediction)

When the "Performance prediction" model is selected, three key geometric parameters 
of the ejector are required:

Table 6: Geometric Parameters for Performance Prediction 

Parameter Unit Description

Nozzle Throat Diameter mm/in Throat diameter at narrowest point

Nozzle Exit Diameter mm/in Exit diameter of primary nozzle

Mixing Chamber Diameter mm/in Constant area section diameter
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3.1.3 Single-Phase Ejector Results

Preliminary Design: The table below shows the results generated with the "Preliminary 
Design" module

Table 7: Results for Single-Phase ejector Preliminary Design 

Note: Units shown are indicative; actual units may vary depending on user selection or 
design setup.

The three calculated ejector key geometric parameters are displayed on the ejector 
schematic for visual reference and validation.

Performance Prediction : The table below shows the results generated with the 
"Performance Prediction" module. 

Table 8: Results for Single-Phase ejector Performance Prediction 

Note: Units shown are indicative; actual units may vary depending on user selection or 
design setup.

Parameter Unit Description

Primary Mass Flow Rate kg/s Calculated motive fluid flow rate

Secondary Mass Flow Rate kg/s Calculated suction fluid flow rate

Entrainment Ratio - Maximum achievable entrainment ratio 

Critical Outlet Pressure kPa Maximum achievable outlet pressure 

Outlet Temperature °C Calculated discharge temperature

Parameter Unit Description

Entrainment Ratio - Entrainment ratio at critical conditions

Outlet Temperature °C Calculated discharge temperature

Secondary Mass Flow kg/s Calculated suction fluid flow rate

Nozzle Throat Diameter mm Calculated throat diameter

Nozzle Exit Diameter mm Calculated exit diameter

Mixing Chamber Diameter mm Calculated constant area section diameter
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3.2 TWO-PHASE CO² EJECTOR ANALYSIS

3.2.1 Input Operating Parameters

For the analysis of two-phase ejectors using CO² as working fluid, required inputs on ope-
rating conditions include pressure and temperature for both the motive fluid (primary flow) 
and the suction fluid (secondary flow), the primary mass flow rate, and either the desired 
outlet pressure or the secondary mass flow rate.

Table 9: Two-Phase CO² Ejector Input Parameters

CO² Two-Phase Limitations 

Two-phase CO²  ejector analysis is subject to additional constraints:

• Operating conditions must be within CO²  thermodynamic boundaries
• Phase change considerations affect calculation convergence
• Critical point proximity requires careful parameter selection

The software automatically handles phase equilibrium calculations using CoolProp.

Default Value Modification

A default value is provided for the loss coefficient of the ejector’s mixing chamber. 
This default value can be replaced with a user-defined value by checking the "Allow 
value modification" box.

Parameter Unit Default Description

Primary Pressure kPa - Motive fluid pressure

Primary Temperature °C - Motive fluid temperature

Secondary Pressure kPa - Suction fluid pressure

Secondary Temperature °C - Suction fluid temperature

Primary Mass Flow Rate

kPa

- Motive fluid flow rate

Outlet Pressure - Desired outlet pressure

Secondary Mass Flow Rate kg/s -
Suction fluid flow rate
(alternative to outlet pressure)

Loss Coefficient - 0,78
Mixing chamber loss coefficient (default 
provided)

kg/s
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3.2.2 Input Geometric Parameters (Performance Prediction)

Three key geometric parameters of the ejector are also required when the "Performance 
prediction" model is selected:

Table 10: Geometric Parameters for Two-Phase CO²

3.2.3 Two-Phase CO² Ejector Results

Preliminary Design : The table below shows the results generated with the "Preliminary 
Design" module.

Table 11: Results for Two-Phase CO² Ejector Preliminary Design

Note: Units shown are indicative; actual units may vary depending on user selection or 
design setup.

The three calculated key geometric parameters are displayed on the ejector schematic for 
visual reference and validation.

Parameter Unit Description

Entrainment Ratio - Maximum achievable entrainment ratio

Outlet Quality % Vapor quality at discharge

Outlet Temperature °C Calculated discharge temperature 

Critical Outlet Pressure kPa Maximum achievable outlet pressure

Primary Flow State - State of primary flow (subcritical/supercritical)

Secondary Flow State - State of secondary flow (subcritical/supercritical)

Nozzle Throat Diameter mm Calculated throat diameter

Nozzle Exit Diameter mm Calculated nozzle exit diameter

Mixing Chamber Diameter mm Calculated constant area section diameter

Parameter Unit Default Description

Nozzle Throat Diameter mm/in - Throat diameter at narrowest point

Nozzle Exit Diameter mm/in - Exit diameter of primary nozzle

Mixing Chamber Diameter mm/in - Constant area section diameter
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TROUBLESHOOTING

4.1 COMMON ISSUES AND SOLUTIONS

4.1.1 Input Parameter Issues

Parameter Validation Errors  

Symptoms:

• Calculation fails after starting
• Error messages about invalid parameters
• Inconsistent results

Solutions :

1. Verify all input fields contain valid numeric values
2. Check parameter ranges are within acceptable limits
3. Ensure geometric parameters are positive values
4. Validate temperature and pressure combinations

04

Performance Prediction : The table below shows the results generated with the 
"Performance Prediction module".

Table 12: Results for Two-Phase CO² Ejector Performance Prediction

Note: Units shown are indicative; actual units may vary depending on user selection or 
design setup.

Parameter Unit Description

Primary Mass Flow Rate kg/s Calculated motive fluid flow rate

Secondary Mass Flow Rate kg/s Calculated suction fluid flow rate

Entrainment Ratio - Maximum achievable entrainment ratio

Critical Outlet Pressure kPa Maximum achievable outlet pressure

Outlet Quality % Vapor quality at discharge

Outlet Temperature °C Calculated discharge temperature

Primary Flow State - State of primary flow

Secondary Flow Phase - State of secondary flow phase
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4.1.2 Calculation Convergence Issues

Convergence Problems  

Symptoms:

• Long calculation times
• Inconsistent results between similar cases
• Calculation termination without results

Solutions :

1. Adjust initial pressure estimates
2. Modify operating conditions within fluid limits
3. Try different efficiency values
4. Use more conservative parameter estimates

4.1.3 Fluid Property Issues

Fluid Property Errors  

Symptoms:

• Error messages about fluid properties
• Unrealistic operating conditions
• Phase boundary violations

Solutions :

5. Check temperature and pressure within fluid limits
6. Verify fluid selection matches application
7. Adjust operating conditions away from critical points
8. Ensure appropriate phase conditions for selected model
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4.2 TIPS

Calculation Best Practices

1. Input Parameters Validation:
Always verify input parameters before calculation

2. Fluid Limits:
Check temperature and pressure within fluid property boundaries

3. Conservative Estimates:
Start with realistic operating conditions

4. Module Selection:
Choose the appropriate module for the desired  objective

5. Result Verification: 
Cross-check results with expected ranges

6. Documentation:
Save successful configurations for future reference
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ANNEX

5.1 BASIC CONCEPTS 

5.1.1 Ejector Operating Principle

An ejector is a device used to move and compress fluids or gases by utilizing the Venturi 
effect. It operates based on the principle of fluid dynamics, which states that as the velo-
city of a fluid increases, its pressure decreases.

The operating principle of the ejector is quite similar to that of the conventional compres-
sor. In a conventional compressor, electrical power (Welectric) is used to compress a given 
mass flow rate of fluid (m fluid) at a given compression ratio. The compression ratio is the 
ratio of the discharge pressure to the suction pressure (Pdischarge/Psuction).

In the case of the ejector, the power input comes from the motive fluid (Wmotive); it is a 
function of its pressure and mass flow rate. Using the motive fluid, the ejector allows com-
pressing a given mass flow rate of a suction fluid (msuction) at a given compression ratio.

5.1.2 Performance Characteristics

In both the conventional compressor and the ejector, for a given power input, the suction 
mass flow rate is inversely proportional to the compression ratio. This relationship is of 
vital importance for applications requiring pressure buildup, steam compression, or fluid 
circulation.
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5.2.2 Operating Pressures

Three key operating pressures determine ejector performance:

1. Primary Pressure (P1): The motive fluid’s pressure
2. Secondary Pressure (P2): The suction fluid’s pressure
3. Outlet Pressure (Pout): The pressure at the ejector’s outlet

5.2 EJECTOR PARAMETERS AND KEY PERFORMANCE METRICS

5.2.1 Geometric Parameters

The ejector’s design and performance depend on several critical parameters, including 
three main geometric dimensions (calculated with the tool):

1. Diameter of the Mixing Chamber (Dmix):
The diameter of the section of the ejector between the convergent and the diffuser 
sections

2. Diameter of the Primary Nozzle Throat (Dthroat):
The diameter at the narrowest point of the primary nozzle that controls the motive fluid 
mass flow rate

3. Diameter of the Primary Nozzle Exit (Dexit):
The diameter where the motive fluid exits the nozzle

Figure 1: Schematic of an ejector with main geometrical parameters
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5.2.3 Key Performance Metrics

There are two main performance metrics for an ejector: the entrainment ratio and the 
compression ratio.

Entrainment Ratio (ω): The entrainment ratio (ω) measures the ejector’s ability to draw 
and mix the secondary fluid into the primary fluid stream. It is calculated as the ratio of 
the suction fluid (m2) mass flow rate to the motive fluid (m1) mass flow rate: 

(1)

Figure 2: Typical performance curve of a gas-gas ejector

At low outlet pressures (Pout), the ejector is operating "on-design", and the entrainment 
ratio remains constant up to the critical outlet pressure (Pout−crit). In this state, both mo-
tive and suction flow are choked. Beyond the Pout−crit, the ejector operates "off-design" 
with a decreasing entrainment ratio.

The behavior can be summarized as:

• m² remains constant when Pout < Pout−crit
• m² decreases when  Pout > Pout−crit

ω = m 2
      m¹
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Compression Ratio: The compression ratio represents the pressure increase of the 
suc-tion flow achieved by the ejector:

For optimal performance, the ejector should operate close to its critical outlet pressure, 
where the compression ratio (Pout-cri t/P2) is maximized for ω = ω crit. Depending on the
application, either the entrainment ratio or the compression ratio may be prioritized as the 
key performance parameter.

5.3 THE SCIENCE BEHIND THE CALCULATION TOOL  

CanEJEX software calculation tool incorporates two one-dimensional thermodynamic 
models: the "Preliminary Design Model" and the "Performance Prediction Model" deve-
loped for both single-phase (gas/gas) and two-phase CO² ejectors. The models utilize:

1. Isentropic Flow Relations:
For nozzle calculations and throat analysis

2. Momentum Conservation:
For mixing chamber analysis

3. Energy Conservation:
For thermodynamic property calculations

4. Mass Conservation:
For flow rate determinations

5. Homogeneous Equilibrium Model:
For two-phase flow analysis

References at the end of the user manual are provided on ejector applications and 
modeling approaches. 

Compression Ratio = Pout
P² (2)
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5.4 FLUID PROPERTIES

Users can select from a predefined set of fluids, with the flexibility to expand options  
to include other fluids. The thermodynamic properties of these fluids come from the free 
CoolProp package, and more information on each fluid can be found in the CoolProp  
documentation.
For "Natural gas mixture", a coded equation of state is used; when this option is selected, 
the exact mixture composition has to be specified.

Fluid Property Limitations

The software automatically determines fluid property limits using CoolProp:

• Temperature Limits:
Minimum and maximum temperatures for each fluid

• Pressure Limits:
Maximum pressure boundaries for thermodynamic calculations

These limits vary significantly between fluids and are automatically enforced during calcu-
lations.

Table 13: Corrected Fluid Property Limits (from CoolProp 7.x) 

     

Fluid Tmin (K) Tmax (K) Pmax (kPa)

CO2 216.6 2 000,0 800,000

R134a 169.9 455,0 70,000

CH4 90.7 625,0 1,000,000

Air 59.8 2 000,0 2,000,000

H2 14.0 1 000,0 2,000,000
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Term Definition

ACA Cross section area of the ejector’s constant area section

Athroat Cross section area of the nozzle throat

Dexit Diameter of the nozzle exit

Dthroat Diameter of the nozzle throat 

m¹, mmotive Mass flow rate of the primary/motive fluid

m², msuction Mass flow rate of the secondary/entrained fluid

mfluid Mass flow rate of the fluid

P¹ Primary pressure (pressure of the motive fluid)

P² Secondary pressure (pressure of the suction fluid)

Pout Outlet pressure of the ejector (discharge pressure)

Pout-crit Critical outlet pressure of the ejector (critical discharge pressure)

ω Entrainment ratio

Welectric Electric power

Wmotive Kinetic power provided by the motive fluid

CFD Computational Fluid Dynamics

CoolProp Thermodynamic property library
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CONTACT INFORMATION AND TECHNICAL 
SUPPORT

For technical support, licensing information, or to learn more about the CanEJEX sof-
tware, please contact the development team through the following channel:

Technical Support Channel

User Support: For assistance or questions,
please contact: CanEJEX@nrcan-rncan.gc.ca.

SOFTWARE INFORMATION

CanEJEX - Ejector Calculation Tool
Version 1.0
By downloading the software, the user accepts the terms and conditions set forth in the
end-user license agreement.

ISBN : 978-0-660-99757-5
Catalog No.: M154-218/2026E-PDF

© His Majesty the King in Right of Canada,
represented by the Minister of Natural Resources Canada, 2026 
All rights reserved
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